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Exercice 1: Détection de méson D?

Appuyer sur Event Display

Event Display

pour commencer 1’exercice 1
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Exercice 1: Détection de méson DO Simulation du détecteur avec des traces

Recherche de DY

des particules chargées - vous pouvez

bouger le détecteur avec votre souris

Event Display Exercise

Event handler Particle information My particles
event_1_0.json E 3667.816 MeV
previous chi2 1.495 Mass
ipchi2  4.241 MeV/c?
2
next mass  139.570 MeVic
name pi- Add
View ZFstM 64.407
» Zoom
Detector
1.0+
» Help
0.9
View v

[] Auto rotate

Legend
K —
K+
pi*
pi-
DO

00 T T T T T T T T T T J
1,810 1,820 1830 1,840 1850 1,860 1,870 1,880 1,890 1,900 1910 1,920

DO invariant Mass (MeV/c2)

Read instructions

Download JSON




Exercice 1: Détection de méson D"

Recherche de DV — K—=*

Event Display Exercise

Event handler

event_1_0.json

previous
next
View

» Zoom
Detector

» Help
View v

[] Auto rotate

Read instructions

Download JSON

Chaque couleur correspond a une particule

Particle information

E

chi2
ipchi2
mass
name
ZFstM

:

§ 0.8
B 7
0.6
0.5
0.4 -

0.3

0.2

0.0

3667.816
1.495
4.241
139.570
pi-
64.407

My particles
MeV
Mass
MeV/c?
MeV/c?

Add

1,810

T T T T T T T T T T J
1,820 1,830 1,840 1850 1860 1,870 1,880 1,890 1900 1910 1820

DO invariant Mass (MeV/c2)



Exercice 1: Détection de méson D’
Recherche de DY — K7

Event Display Exercise

Event handler

Particle information My particles
event_1_0.json E 3667.816 MeV
previous hi2 1.495 Mass
i, Z00M: Vue de la région autour de la collision == 2+ = . N
N — P ame i- Add
o DETECTOR: afficher (ou cacher) le détecteur ruu seaor
» Zoom
o HELP: Afficher le D’
View v 1 ) N N

0.8

DO Candidates (0.6

[] Auto rotate .71
0.6+
054
0.4+
034

0.2

0.1

00 T T T T T T T T T T J
1,810 1,820 1830 1,840 1850 1,860 1,870 1,880 1,890 1,900 1910 1,920

DO invariant Mass (MeV/c2)

Read instructions

Download JSON



Exercice 1: Détection de méson D?

Recherche de D° — K=t

Event handler

My particles
event_2_0.json 9682.464 K-
previous 1643
75.965 Mass
next 493,677 Mevjc?
K-

View 169.454 Add

» Zoom

" Detector

» Help 104

3
View v 3 094
[] Auto rotate g =
8 0.7+

Legend is-
K™ — . . ’ . 7 .
Kt — Si vous placez votre souris sur une trace, elle sera sélectionnée (en jaune)
Pit  — . . . 7 \ .
o — et ses informations seront affichées a droite
D0 1

Read instructions 1.9‘0' |.320' |.830' |.840' |.850' l.BﬁO‘ LB70‘ 1.8‘&)‘ 1.&)‘ |,ﬁn’ 1.9‘0‘ |.920l

DO Invariant Mass (MeVic2)
Download JSON



Exercice 1: Détection de méson D?

Recherche de D° - K~ 7

Event handler

Particle information y particles
event_2_0.json E 9682.464 MeV K-
previous chi2 1.643
ipchi2 75.965 Mass
next mass 493677  Mevic? MeV/c?
name K-
View ZFstM  169.454 Add
» Zoom
» Detector
» Help . 9 s \ .
Cliquez dessus pour ’ajouter a la liste
View v g 09+
08+
[] Auto rotate
8 0.7+
064
05+
Legend
0.4
K o
o — 03
pi+ p—_— 02+
Pi7  —
DO e 0.1+
00 T T T T T T T T T T "
Read instructions 1810 1820 1830 1840 1850 1860 1870 1880 1890 1900 1910 1920

DO Invariant Mass (MeV/2)
Download JSON



Exercice 1: Détection de méson D?

Recherche de D° - K~ =t

Event handler
event_2_0.json

previous Cliquez sur une deuxiéme particule, et le logiciel
next calculera la masse de la combinaison

View
» Zoom
» Detector

» Help
View v

| Auto rotate

Legend

pi-
Do

Read instructions

Download JSON

Particle information

E

chi2
ipchi2
mass
name
ZFstM

0.9

0.8

DO Candidates (0.5 MeV

0.7

0.6

0.5+

0.4

03+

02+

0.0

My particles

12083.039 MeV K-

1.337 pi+

44.572

139.570 MeV/c? Mass

pi+ 1868.792 MeV/c?
49.322

Fate o)

1,810

T T T T T T T T T T 1
1820 1,830 1840 1850 1,860 1870 1,880 1890 1900 1910 1920
DO Invariant Mass (MeV/c2)



Exercice 1: Détection de méson D?

Event handler
event_2_0.json

previous

next

View
» Zoom
» Detector
m Help

View

[ Auto rotate

Legend
K-
KO
pit
pi”
DO

Read instructions

Download JSON

Recherche de D° — K=t

Cliquez sur une deuxiéme particule, et le logiciel
calculera la masse de la combinaison

St vous souhaitez enregistrer la combinaison,
cliquez sur Add et sa masse sera ajoutée a I’histogramme

Sinon, cliquez sur une autre particule pour recommencer

Particle information

E

chi2
ipchi2
mass
name
ZFstM

12083.039
1.337
44572
139.570
pi+
49.322

MeV

MeV/c?

My particles
K-
pi+

Mass
1868.792 MeV/c?

=D

0.6

05

0.4

0.3

0.2

Entries 1
Means: 1868.792
Std dev: undefined

/

DO Invariant Mass (MeV/c2)

T T T T T T T T T
1820 1,830 1840 1850 1860 1870 1,880 1,890 !W




Exercice 1: Détection de méson D?

Event handler
event_2_0.json

previous
next
View

» Zoom

» Detector
» Help

View v

O Auto rotate

Legend
K-

pi*
pi-
DO

Read instructions

Download JSON

Recherche de D° - K~ =t

Vous pouvez parcourir les différents événements avec les
boutons Previous et Next (30 événements par binome)

Particle information

E

chi2
ipchi2
mass
name
ZFstM

094

08+

DO Candidates (0.5 MeV

0.7+

0.6

05+

12083.039
1.337
44,572
139.570
pi+
49.322

My particles
MeV K-
pi+
MeV/c? - Mass
1868.792 MeV/c?
Add
Entries 1

Means: 1868.792
Std dev: undefined

0.0

T T T T T T T T T 1
1810 1820 1830 1840 1850 1860 1870 1,880 1890 1900 1910 1920

DO Invariant Mass (MeV/2)



Exercice 1: Détection de méson D’
Recherche de D° - K=+

Event handler
event_2_0.json

previous Une fois que vous avez identifié les désintégrations D* — K=n™*
nead dans vos échantillons
View
» Zoom
» Detector
» Help

Sauvegardez votre histogramme, les résultats de chaque binome
seront combinés.

View v

[] Auto rotate

Legend
K-
K+
pit
pi-
DO

Read instructions

( Download JSON ’ ‘:

Particle information

E 12083.039
chi2 1.337
ipchi2 44,572
mass 139.570
name pi+

ZFstM 49.322

DO Candidates (0.5 MeV

1.0+

09+

0.8

0.7+

06+

0.5 -

04~

03+

0.2

0.1+

00

MeV

MeV/c?

My particles
K-
pi+

— Mass -

1868.792 MeV/c?

Add

Entries 1
Means: 1868.792
Std dev: undefined

DO Invariant Mass (MeV/c2)

T T T T T T T T T 1
1810 1820 1830 1840 1850 1860 1870 1880 1890 1900 1910 1920



Exercice 2: Mesure the temps de vie

Appuyer sur D0 Lifetime

Event Display

pour commencer 1’exercice 2
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Exercice 2: Mesure the temps de vie

DO lifetime Exercise

Analysis tools

Background substr.
Signal range
1810

Plot distributions

— Variable range

. Bruit de fond
Sur le spectre de masse, on peut identifier la
o présence du signal (vrais DY) mais aussi de
i bruit de fond.
(ps)

Read instructions



Exercice 2: Mesure the temps de vie

1,860 1,870

DO lifetime Exercise

Analysis tools

Plot DY mass.

Plot distributions

Variable range
DO PT
25 20

D° TAU
0 10

o° P

Refresh

Time fit

Fit result  Fit Error
(ps)

1,830 1,840 1,850

1,810 1,820

Save result

Read instructions

1,880 1,890 1,900

On peut réaliser un ajustement pour estimer

le nombre d’événements dans chaque catégorie

Total 54352
Background : 25755
Signal : 28597
Mean : 1866.5 + 0.1
Deviation : 8.2 £ 0.1

i

1,910 1,920
DO Invariant Mass (MeV/c2)



Exercice 2: Mesure the temps de vie

DO lifetime Exercise On peut réaliser un ajustement pour estimer
Analysis tools e, 4 , &
L le nombre d’événements dans chaque catégorie
m— 2 1600 Total 54352
Fit mass distribution 3 \ 'ac roun .
e _ Signal : 28597
Background sub 1.400 - 4 Mea.n :. 1866-5 . 0-1
Signal range ! i ‘ Deviation: 8.2 + 0.1 gl P
l‘ g Total: nombre d’événements
S g dans | ’histogramme
Variable range -
Time fit
F‘I’t‘r)esun Fit Error

Save result

1,810 1,820 1,830 1,840 1,850 1,860 1,870 1,880 1,890 1,900 1,910 1,920
Read instructions m m m MVI&)



Exercice 2: Mesure the temps de vie

DO lifetime Exercise

Analysis tools

Plot D mass

Plot distributions

Variable range
D°PT

D° TAU
0

D°Ip

Refresh

Time fit

Fitresult Fit Error
(ps)

Save result

Read instructions

On peut réaliser un ajustement pour estimer

i, le nombre d’événements dans chaque catégorie

1,600 otal 54
Moan : 1866.5 + 0.1
Deviation : 8.2 # 0.1 Background: nombre
d’événements estimé du

i

bruit de fond

i

1,810 1820 1,83 1,840 1,850 1,860 1870 1,880 1,890 1,900 1,910 1,920
DO Invariant Mass (MeV/c2)



Exercice 2: Mesure the temps de vie
On peut réaliser un ajustement pour estimer

DO lifetime Exercise

Analysis tools

le nombre d’événements dans chaque catégorie
Total 54352

Plot DY mass. -
>

Signal : 28597
Mean 1866.5 + 0.1
Deviation : 8.2 + 0.1

Signal: nombre d’événements estimé du
signal (modélisé par une Gaussienne)

Mean: centre du pic

Deviation: largeur du pic

I

\



Exercice 2: Mesure the temps de vie

DO Candidates (0.5 MeV

1,600

1,400 —

1,200

1,000 —

800 —

600 —

400

200

Il

1,810 1,820 1,830 1,840 1,850 1,860 1,870 1,880 1,890 1,900 1,910 1,920
DO Invariant Mass (MeV/c2)

|

I

i

P¥Total 54352
¢Background : 25755

l|S|gna 28597
Mean : 1866.5 + 0.1

¥Deviation : 8.2 + 0.1

ot T T e T T T e T T
' OB B B SN BN BN SN BN BN BN BN BN BN BN B B .

I

— On voit apparaitre 2 regions:

» Une avec uniquement du bruit de
fond (en rouge)

» Une avec un mélange de signal et de
bruit de fond (en bleu)

— Difficile de séparer le signal du bruit de
fond en utilisant que la masse

- Objectif:

> En se placant dans la zone rouge,
regarder comme se comporte le bruit
de fond sur d’autres variables.




Exercice 2: Mesure the temps de vie

DO lifetime Exercise

Analysis tools

Plot D? mass

Fit mass distribution

Variable range
D°PT
25

DO TAU
[}

%P

Refresh

Time fit

Fitresult  Fit Error
(ps)

Save result

DO Candidates (0.5 MeV

;o B 8888 ¢

:

Total 54352
Buckqvound : 26756
Signal : 28597

Mean : 1866.5 + 0.1
Deviation : 8.2 + 0.1

Ui

10 1,820 1,830 1840 1850 1860 1870 1880 1890 1900 1810 1,920
DO Invariant Mass (MeV/c2)

Vous pouvez définir les régions précédentes en bougeant les curseurs



Exercice 2: Mesure the temps de vie

Et afficher le comportement de chaque régions sur différentes variables
D lifetime Exercise

Plot D° mass T Total 54338 1 W Signal M Signal
A 1 L] Background : 25766 1w Background WFit
; 28583 | 2043
14004 1 * Me:
§ S 1
Fit mass distribution 1 By DO lifetime 0.484 £ 0.0041
1200 ' [
8 1 L] 8 8
1000 g 1
Background substr. Iy 2
Signal range so * .
1839 1880 s 1 g
p— 1 * 1
i) Rl i '
(s Mo
AN Il | | il | Ul
. 0 : : : |
Variable range 810 1,820 1830 1,840 1,850 1,860 1,870 1,880 1,890 1,900 1910 1920 14 16 "

DO PT (GeVi2) DO decay time (ps)

DOPT DO Invariant Mass (MeV/c2)
25 20 2 .
M Signal M Signal
W Background W Background
D° TAU
o 10 ’ i
b1 8 0.52
%P i 050
048
a 15 8
046
044
Refresh 042
040 1=(410.1215) x%0-158
Time fit 0%
036
r“';““" Fit Error ¥ i 40 A5 A0 25 20 18 0 05 00 05 10 15 20
P 0.0041 DO decay tme (pe) 10g10(D0 IP (mem) 1910 00 IP grum)

0.484

Save result vo.1



Exercice 2: Mesure the temps de vie

DO lifetime Exercise
Analysis tools
= : : M Signal M Signal
0 4 H ; .
Plot D mass i 1,600 ' ¢ Lﬁ:;ﬁﬁ; 25755 i W Background E WFit
. | A o, o
! 1,400 ! | Deviation: 8.2 + 0.1 1 g
Fit mass distribution ! ;
1,200 ' :
8 : : 8 :
1,000 H i
Background substr. : '
Signal range 00 E E
1839 1880 600 H \
o— ! 4
sl H
Plot distributions
200
— Variable range 1810 1820 1,830 1,840 1,850 1,860 1,870 1,880 1,890 1,900 1,910 1820 Sd

DO PT DO invariant Mass (MeV/c2) DO PT (GeVic2) DO decay time (ps)
25 20 ! ] Signal ! Te-t 3 [} signa|
W Background W Background
i I il
—0 | § Ajustement a la distribution du temps de désintégration du signal:

o°ip .
: — Mesure du temps de vie

Refresh :.::
Time fit 038+
Zits;esult Fit Error 1 20 “‘-:n 35 90 25 20 45 40 05 00 05 10 15 20

0.0041 D0 decay tme (pe) 1og 1000 1P ) kbt

0.484

Save result vo.1



Exercice 2: Mesure the temps de vie

DO lifetime Exercise — Vous pouvez changer la
m— : . - o selection sur les autres
o | | B meecorond | variables pour mieux
e g - séparer le bruit de fond du
el e

h — Afin de réaliser une
N LTI mesure du temps de vie

ariable range 810 1820 1,830 1,840 1,850 1,860 1870 1,880 1890 1,900 1,910 1,920 2 4 14 16 18 20 0 7
oot D0 ot o B ePreman de D" sur des données

A i Vous pouvez définir les les coupures, B Signal
|

Plot distributions

g Background avec le moins de bruit de
fond possible

et appuyez sur Refresh pour les appliquer

2e-4
Ted

Refresh 205

165

Time fit 206

) 8 If | | |
Fit result  Fit Error 40 35 30 -25 20 -15 10 05 00 06 10 15 20

(ps) 0.0041 DO decay ime (pe) 10g10(D0 IP (mem))
0.484

Save result Vo1




Exercice 2: Mesure the temps de vie

-Sow
T i !

||II|||M .

. s
.= '|||‘|“.-"M
I T o S

o= [N
. 1
! '
' 1
' 1
! 1
0.50 ] '
! 1
0.48 8.
8 R
0.46 | i 1
: m
N e — = el s s s e s - a
] 0
' 10 1 |
B Ampg s - ------ o
f + S T=(410.1+15) x 10-15 s
Time fit 0.40 £ ) ( ) x
]
Fitresult  Fit Error 0.38 - . 1
]
(ps) 0.0033 v
0.428 0.36 g &
T 1 1 1 1 ul ¥ 1 1 1 1 1 1
STy 40 85 30 25 20 15 0 05 00 05 10 15 20
fis .8 log10 DO IP (mm)
' 1
oy

Résultat (temps de vie) avec incertitude Coupure haute sur IP



Pour les TDs

- Open main page https://lhcb-d0.web.cern.ch/ in each laptop

- AT THE END OF EXERCISE 1:
- Save the JSON files with histograms, rename them

calculated_masses_{combinationNB}.json and put them in shared folder

- Follow instruction on https://gitlab.cern.ch/tfulghes/Masterclass
-  SUGGESTION: Copy all the files into a local directory in your laptop

- AT THE END OF EXERCISE 2:

- Report values for each combination in this link (keep same order)

- Use comma to report decimal numbers, not points and download in csv format


https://lhcb-d0.web.cern.ch/
https://gitlab.cern.ch/tfulghes/Masterclass
https://docs.google.com/spreadsheets/d/1IReC5ubtG-Io7SZ4F8i3EZqkWVRkSz_iIbv7hz_Nvlk/edit?usp=sharing

